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Chapter 1

Getting Dirty: The Basics of Civil 3D

Just as with any piece of software, understanding Civil 3D’s controls and operation is critical to its
mastery. With a dizzying array of options and settings, getting Civil 3D to just look and feel com-
fortable can take some effort. A whole new host of dialogs and tool palettes are critical to driving
Civil 3D and getting feedback about your design. In this chapter, we'll explore the makeup of Civil
3D as a CAD program, the unique components that make up the Civil 3D interface, and how you
can create a working environment that matches the way you design.

By the end of this chapter, you will be able to:

Find any Civil 3D object with just a few clicks
Modify the drawing scale and default object layers
Modify the display of Civil 3D tooltips

Add a new tool to the Toolbox

Create a basic label style

®* 6 6 & o o

Create a new object style

Windows on the Model

If you're familiar with AutoCAD, opening up Civil 3D won’t bring any major surprises—until you
look a little further. Civil 3D is a design package for the civil engineer, so special tools are needed.

The most obvious change to the interface is the addition of two new palette sets that you
won’t find in any other Autodesk product: Toolspace and Panorama. These two palette sets
offer Civil 3D users a way to interact with their data and watch their design change unlike any-
thing previously offered. Both of these palette sets can be docked and resized like typical
AutoCAD palettes and toolbars, making their use on screen as flexible as you like. Most users
find that they are constantly referring to information displayed in these palette sets, so Tool-
space and Panorama remain open nearly all the time. Figure 1.1 shows both of these palette sets
displayed in a typical environment.
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CONFUSED YET?

Bothered by the naming convention yet? After discussion with the Civil 3D team in Manchester, New
Hampshire, we think we have it right. Toolspace and Panorama are palette sets, acting as containers for
the palettes they contain. Examples of palettes are Event Viewer, Settings, Elevation Editor, and so on.
We will use the terms tools, tabs, and palettes pretty much interchangeably throughout the text
because we find that’s how they are referred to in the wild. Apologies in advance for any confusion—
we’ve been using program for five years and still had to get an official ruling from Autodesk!

Toolspace

Toolspace is one of the unique Civil 3D palette sets. Toolspace can have as many as four tabs to
manage user data:

¢ DProspector

¢ Settings
¢ Survey
& Toolbox

Using a Microsoft Windows Explorer-like interface within each, these tabs drive a large portion of
the user control and data management of Civil 3D.

+/@
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PROSPECTOR
Prospector is the main window into the Civil 3D object model. This palette or tab is where you

“gomining” for data and also shows points, alignments, parcels, corridors, and other objects as one
concise, expandable list. In addition, in a project environment this window is where you will con-
trol access to your project data, create references to shared project data, and observe the check-in/

check-out status of a drawing. Finally, you can also use Prospector to create a new drawing from
the templates defined in the Drawing Templates branch in your AutoCAD Options dialog. Pros-
pector has the following branches:

¢ Open Drawings
¢ DProjects

¢ Drawing Templates

MASTER AND ACTIVE DRAWING VIEWS

If you can’t see the Projects or Drawing Templates branch in Figure 1.1, look at the top of the Prospector
pane. There is a dropdown menu for operating in Active Drawing Only or Master View mode. Selecting
Active Drawing Only only displays open drawings. The Master View mode, however, displays the
Projects and Drawing Templates branches, as well as the branches of any other drawings you might
have open.

In addition to the branches, Prospector has a series of icons across the top that toggle various
settings on and off:

Project State Toggle Turns on and off the display of project item state icons in the Prospector
palette—very important when you're working with a team of designers so that you know when

others have made changes to project-related data. Leave this one on!

Drawing State Toggle Turns on and off the display of the drawing item state icons in the
Drawings collection. This is how you know that an object is in use, has been modified, or has

dependent objects—profiles that depend on alignments. This same button on the Settings tab of

Toolspace will turn on the icons that indicate a style is in use or has dependencies that keep it
from being deleted. Another one to usually leave on.

Modifier Toggle Turns on and off the display of the drawing item modifier icons at the indi-

vidual object level. For example, these icons will inform you when a surface is out of date or

when a corridor needs to be rebuilt. This information is important when working with project

data that has been referenced to your current drawing.

Item Preview Toggle Turns on and off the display of the Toolspace item preview within Pros-

pector. These previews can be helpful when you're navigating drawings in projects (you can
select one to check out) or when you're attempting to locate a parcel on the basis of its visual
shape. In general, however, this one can be turned off—it’s purely a user preference.

Panorama Display Toggle Turns on and off the display of the Panorama window (which

we’ll talk about in a bit). To be honest, there does not seem to be a point to this button, but it’s

here nonetheless.

Help This should be obvious, but it's amazing how many people overlook it.

%
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HAVE YOU LOOKED IN THE HELP FILE? LATELY?

In the past, the included Help files were notoriously bad. Since Civil 3D’s creation, the team in Manchester,
New Hampshire, has worked hard to make the Help files in Civil 3D top notch and user friendly. The
Help files should be your first line of support!

Open Drawings

This branch of Prospector contains the drawings currently open in Civil 3D. Each drawing is then
subdivided into groups by major object type, such as points, point groups, surfaces, and so on.
These object groups then allow you to view all the objects in the collection. Some of these groups
are empty until objects are created. You can learn details about an individual object by expanding
the tree and selecting an object. See Figure 1.2 for a typical parcel object’s display in Prospector.

Within each drawing, the breakdown is similar. If a collection isn’t empty, there will be a plus
sign next to it, as there is next to the second Alignments collection in Figure 1.2. Selecting any of
these top-level collection names displays a list of members in the preview area. Right-clicking on
the collection name allows you to select various commands that apply to all the members of that
collection. For example, right-clicking on the Point Groups collection brings up the menu shown in
Figure 1.3.
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In addition, right-clicking on the individual object in the list view offers two more commands
unique to Civil 3D: Zoom To Object and Pan To Object. By using these commands, you can find any
parcel, point, cross section, or other Civil 3D object in your drawing nearly instantly.

Many longtime users of AutoCAD have resisted right-clicking menus for their daily tasks. In
other AutoCAD products that might be possible, but in Civil 3D you'll miss half the commands! We
will focus on the specific options and commands for each object type when we talk about the objects
in particular.

Projects

The Projects branch of Prospector is the starting point for real team collaboration. This branch
allows you to sign in and out of Vault, review what projects are available, manage the projects you
sort through for information, check out drawings for editing, and review the status of drawings, as
well as that of individual project-based objects. We’ll spend much more time talking about the
Project branch in Chapters 19 and 20.

Drawing Templates

The Drawing Templates branch is added more as a convenience than anything else. Creating new
drawings can still be done via the standard File > New option, but by using the Drawing Templates
branch, you can do the same thing without ever leaving Prospector. The Drawing Templates branch
searches the file path specified in your AutoCAD Options dialog and displays a list of all the . dwt
files it finds. You can customize this path to point to a server or other folder, but by defaultit’s a
local user settings path. Right-clicking on the name of a template presents you with the options
shown in Figure 1.4.

FIGURE 1.4
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Civil 3D is built on both AutoCAD and Map, so Civil 3D 2008 comes with a variety of templates.
However, most users will want to select one of the top few, which start with _Autodesk Civil 3D
and then have some descriptive text. These templates have been built on the basis of customer feed-
back to provide Civil 3D with a varying collection of object styles. These templates give you a good
starting point for creating your own personal template file.

SETTINGS

The Settings tab of Toolspace is the proverbial rabbit hole. Here you will adjust how the draw-
ing relates to the real world, how Civil 3D objects look, and how the Civil 3D commands work.
You control styles, labels, and command settings for each component of Civil 3D here. We'll
start by looking at the top level of drawing settings and a few command settings to get you
familiar, and then we’ll cover the specifics for each object’s styles and settings in their respec-
tive chapters.

CONSISTENCY OF FEEDBACK

Just as in Prospector, the button on the top row toggles the display of the various drawing item state
icons that tell you if a style or label is in use. There’s also a dropdown menu for a few different views of
the Settings window.

Drawing Settings

Starting at the drawing level, Civil 3D has a number of settings that must be understood before the
program can be used efficiently. Civil 3D understands that the end goal of most users is to prepare
construction documents on paper. To that end, most labeling and display settings are displayed in
inches for imperial users and millimeters for metric users instead of nominal units like many other
AutoCAD objects. Since much of this is based on an assumed working scale, let’s look at how to
change that setting, along with some other drawing options.

1. Open the file SampTeSite.dwg from the installed sample files.
2. Switch to the Settings tab.

3. Right-click on the filename and select Edit Drawing Settings to display the dialog shown in
Figure 1.5.

Each tab in this dialog controls a different aspect of the drawing. Most of the time, you will pick
up the Object Layers, Abbreviations, and Ambient Settings from a companywide template. But the
drawing scale and coordinate information change for every job, so the Units And Zone and the
Transformation tabs are visited frequently.

. 4 1|0
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FIGURE 1.5
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Units And Zone Tab

The Units And Zone tab lets you specify metric or imperial units, as well as control the assumed
plotting scale of the drawing. The drawing units typically come from a template, but the options for
scaling blocks and setting AutoCAD variables depend on your working environment. Many engi-
neers continue to work in an arbitrary coordinate system using the settings as shown earlier, but
using a real coordinate system is easy! For example, setting up a drawing for the Dallas, Texas, area,
you’d follow this procedure:

1. Select USA Texas from the Categories dropdown menu on the Units And Zone tab.

2. Select NADS83 Texas State Planes, North Central Zone, US Foot from the Available
Coordinate Systems dropdown menu.

There are literally hundreds, if not thousands, of available coordinate systems. These are estab-
lished by international agreement and because Civil 3D is a worldwide product, almost any recog-
nized surveying coordinate system can be found in the options here. Once your coordinate system
has been established, you can change it on the Transformation tab if desired.

Transformation Tab

With a base coordinate system selected, you can now do any further refinement you’d like using
the Transformation tab. The coordinate systems on the Units And Zone tab can be refined to meet
local ordinances, tie in with historical data, or account for minor changes in methodology. These

changes can include the following;:

Apply Sea Level Scale Factor, which that takes into account the mean elevation of the site and
the spheroid radius that is currently being applied as a function of the selected zone ellipsoid.

Grid Scale Factor, which is based on a 1:1 value, a user-defined uniform scale factor, a reference
point scaling, or a prismoidal transformation in which every point in the grid is adjusted by a
unique amount.

- @
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Reference Point, which can be used to set a singular point in the drawing field via pick or via
point number, local northing and easting, or grid northing and easting values.

Rotation Point, which can be used to set the reference point for rotation via the same methods
as the Reference Point.

Specify Grid Rotation Angle—you enter an amount or set a line to North by picking an angle
or deflection in the drawing. This same method can be used to set the azimuth if desired.

Most engineering firms are working on a defined coordinate system or an arbitrary system with
none of these changes necessary. Given that, this tab will be your only method of achieving the nec-
essary transformation for certain surveying and Geographic Information System (GIS)-based tasks.

Object Layers Tab

Setting object layers to your company standard is a major part of creating the feel you're after when
using Civil 3D in your office. The nearly 50 objects described here make up the entirety of the Civil
3D modeling components and the objects you and other users will be dealing with every day.

The layers listed in this dialog by default reflect a modified National CAD Standard (NCS)
setup. This layering standard is built into many places in Civil 3D’s templates and is becoming
more widely adopted in the land development industry. In addition to being fairly comprehensive
and well known among engineering firms, the NCS has the benefit of being the roadmap for the
future in terms of out-of-the-box content from Autodesk. Adopting this standard means you’ll
have fewer things to change with every release of the software. Nevertheless, every user still needs
know how to modify these defaults.

One common issue with the shipping templates is that the templates assume that road design is
the primary use of alignments. Use the following procedure to change the Alignment setting to the
NCS for laying out a sanitary sewer:

1. Click on the Layer column in the Alignment row, as shown in Figure 1.6.

2. In the Layer Selection dialog list, select C-SSWR-CNTR and click OK.
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ONE OBJECT AT A TIME

Note that this has only changed the Alignment object itself. If you wanted to change the standard of all
the objects, you would need to adjust the Alignment Labeling, Alignment Table, Profile, Profile View,
Profile View Labeling, and so on. To do this, it’s a good idea to right-click in the grid view and select Copy
AlL You can then paste the contents of this matrix into Microsoft Excel for easy formatting and reviewing.

One common question that surrounds the Object Layers tab is the checkbox on the lower left,
Immediate And Independent Layer On/Off Control Of Display Components. What the heck does
that mean? Relax—it’s not as complicated as it sounds.

Many objects in Civil 3D are built from underlying components. Take an alignment, for exam-
ple. It’s built from tangents, curves, spirals, extension lines, and so on. Each of these components
can be assigned its own layer—in other words, the lines could be assigned to the LINES layer,
curves to the CURVES layer, and so on. When this checkbox is turned on, the component’s layer will
exert some control. In the example given, if the alignment is assigned to the ALIGN layer and the
box is on, freezing the LINES layer will make the line components of that alignment disappear.
Turn off this control, and the LINES layer status will not have any effect on the visibility of the
alignment line components.

Finally, it’s important to note that this layer control determines the object’s parent layer at cre-
ation. Civil 3D objects are like any other object in that once they are made, they can be moved to
other layers. Also, changing this setting will not change any objects already in place in the drawing.

Abbreviations Tab

Users can go for years and never notice the Abbreviations tab. The options on this tab allow you to
set the short forms that Civil 3D uses when labeling items as part of its automated routines. The pre-
built settings are based on user feedback, and many of them are the same as the settings from Land
Desktop, the last-generation civil engineering product from Autodesk.

To change an abbreviation, it’s as simple as clicking in the Value field and typing in a new one.
Notice that the Alignment Geometry Point Entity Data section has a larger set of values and some
formulas attached. These are more representative of other label styles, and we will visit the label
editor a little later in this chapter.

THERE’S ALWAYS MORE TO LEARN

It really can be years. Until December 2006, James was still advising users to add a “t.” to their labels to
get “Rt.” or “Lt.” in the final label. He’d forgotten that the abbreviations being used were being set here!
By changing the Left and Right abbreviation from “L” and “R” to “Lt.” and “Rt.,” respectively, that step
in the label setup can be skipped. Sometimes there are just too many options to remember them all!

Ambient Settings Tab

The Ambient Settings tab can be quite daunting at first. These settings control much of the math,
labeling, and display features, as well as the user interaction of Civil 3D. However, being familiar
with the way this tab works will help you further down the line, as almost every other setting dia-
log in the program works just like the one shown in Figure 1.6.

- @
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There are a couple of ways to approach this tab:

¢ Top to bottom—Expand one branch, handle the settings in that branch, then close it and
move to the next.

¢ Print and conquer—Expand all the branches using the Expand All Categories button found on
thelower right .Once you have them expanded, right-click in the middle, and select Copy To
Clipboard and paste to Excel for review, like we did with the Object Layers tab.

SHARING THE WORKLOAD

The second approach makes it easy to distribute multiple copies to surveyors, land planners, engineers,
and so on and let them fill in the changes. Then, creating a template for each group is a matter of making
their changes. If you’re asking end users who aren’t familiar with the product to make these changes, it’s
easy to miss one. Going line by line is pretty well foolproof.

After deciding how to approach these settings, get to work. These settings are either dropdown
menus or text boxes in the case of numeric entries. Many of these are self-explanatory and common
to land development design. The General branch of the Ambient Settings tab is new to Civil 3D, so
let’s look at its settings in more detail (see Figure 1.7).

FIGURE 1.7 =
. . —Ii Drawing Settings - SampleSite
The Ambient Settings
. Uniks and Zone | Transformation | Object Layers | Abbreviations | Amblenk Sstongs
tab with the General s *
branch expanded Propetty Value Ovetride chid Override Lok 4
=l "N General
poted ot iy Ty ol ®
Save Command Changes ko Settings ) L]
Shaw Event Viswer es L)
Show Toakips ves ]
Mew Entity Todl Tip Stake on L]
%
g
; cts -]
Independent Layer On na L]
# T Labeling
= N Unitless
<l "N Distance
+ B Nirneersainn >
>
otbed Uit Display Type: Sets display bype of plotted unit values.
arent Valua: Mif
arent: Current
Lad
[ o J[ canedl [ &y [ v |

Plotted Unit Display Type Remember, Civil 3D knows you want to plot at the end of the day.
In this case, it’s asking you how you would like your plotted units measured. For example,
would you like that bit of text to be 0.25” tall or '/;” high? Most engineers are comfortable with
the Leroy method of text heights (L80, L100, L140, and so on), so the decimal option is the
default.

Save Command Changes To Settings  This setting is incredibly powerful but a secret to
almost everyone. By setting this to YES, your changes to commands will be remembered from
use to use. This means that if you make changes to a command during use, the next time you call

- @
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that Civil 3D command, you won’t have to make the same changes. Since it’s frustrating to do
work over because you forgot to change one out of the five things that needed changing, this set-
ting is invaluable.

Show Event Viewer Event Viewer is Civil 3D’s main feedback mechanism, especially when
things go wrong. It can get annoying, however, and takes up valuable screen real estate (espe-
cially if you're stuck with one monitor!), so many people turn it off. At the end of the day, we
have to recommend leaving it on and simply pushing Event Viewer to the side if needed.

Show Tooltips  One of the cool features that people remark on when they first use Civil 3D is
the small pop-up that displays relevant design information when the cursor is paused on the
screen. This includes things like Station-Offset information, Surface Elevation, Section informa-
tion, and so on. Once a drawing has numerous bits of information, this can be overwhelming, so
Civil 3D offers the option to turn these tooltips off universally with this setting. A better
approach is to control the tooltips at the object type by editing the individual feature settings.
You can also control the tooltips by pulling up the properties for any individual object and look-
ing at the Information tab.

New Entity Tool Tip State The same tooltips that we just discussed can be controlled on an
individual object level. For instance, you might want tooltip feedback on your proposed surface
butnot on the existing surface. This setting controls whether the tooltip is turned on at the object
level for new Civil 3D objects.

Drawing Unit, Drawing Scale, and Scale Inserted Objects These settings were specified on
the Units And Zone tab but are displayed here for reference and so that you can lock them if
desired.

Independent Layer On  This is the same control that was set on the Object Layers tab.

The settings that are applied here can also be applied at the object levels. For example, you might
want elevation to generally be shown to two decimal places, but when looking at surface elevations
you might want just one. The Override and Child Override columns will give you feedback about
these types of changes. See Figure 1.8.

FIGURE 1.8
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The Override column shows if the current setting is overriding something higher up. Since we
are at the Drawing Settings level, these are all clear. However, the Child Override column has a
down arrow symbol, indicating that one of the objects in the drawing has overridden this setting.
After a little investigation through the objects, we find the override is in the Edit Feature Settings
of the Profile View, shown in Figure 1.9.

Notice that in this dialog, the box is checked in the Override column! This indicates that we’re
overriding the settings from earlier, and it’s a good alert that things have changed from the general
Drawing Settings to this Object Level setting.

But what if we don’t want to allow those changes? In each settings dialog, there’s one more col-
umn we haven’t discussed: the Lock column. At any level, you can lock a setting, graying it out for
any lower levels. This can be handy for keeping users from changing settings at the lower level that
perhaps should be changed at a drawing level, such as sign or rounding methods.

FIGURE 1.9
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Object Settings

If you have clicked the expand button next to the drawing name, you'll see the full array of objects
that Civil 3D uses to build its design model. Each of these has some special features unique to the
object being described, but there are some common features as well. Additionally, there’s a General
collection for settings and styles that are applied to various objects across the entire product. Let’s
look at those now.

The General collection serves as the catchall for the styles that apply to multiple objects and to
the settings that apply to 1o objects. For instance, the Civil 3D General Note object doesn’t really
belong with the Surface or Pipe collections. It can be used to relate information about those objects,
but since it can also relate to something like “Don’t Dig Here!” it falls into the general category. The
General collection has three components (or branches), and we’ll look at each.

Multipurpose Styles These styles are used in many objects to control the display of compo-
nent objects. The Marker Styles and Link Styles collections are typically used in cross-section
views, whereas the Feature Line Styles collection is used in grading and other commands. Fig-
ure 1.10 shows the full collection of Multipurpose Styles and some of the Marker Styles that ship
with the product.

%
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FIGURE 1.10
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Label Styles The Label Styles collection was a new addition with the 2007 release of the prod-

uct and a much-requested change at that. These labels allow Civil 3D users to place general text
notes or label single entities outside the parcel network while still taking advantage of the Civil
3D flexibility and scaling properties. With the various Label Styles shown in Figure 1.11, you can
get some idea of the usage.

Since building label styles is a critical part of producing plans with Civil 3D, we will look at how
to build a new basic label and some of the common components that appear in every label style
throughout the product in a later section of this chapter.

Commands Every branch in the Settings tree contains a Commands folder. Expanding this
folder as shown in Figure 1.12, you will find the long, unspaced commands that refer to the par-
ent object.

SURVEY

The Survey palette is displayed optionally and controls the use of the survey, equipment, and fig-
ure prefix databases. Survey is an essential part of land development projects, but because of the
complex nature of this tab, we will devote a whole chapter to it. See Chapter 3 for a full exploration

of the Survey palette.
FIGURE 1.11 %
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FIGURE 1.12 —
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TOOLBOX

The Toolbox was added in Civil 3D 2007 as a launching point for add-ons and reporting functions.
You access and add it to Toolspace by selecting General > Toolbox. Toolbox out of the box contains
reports created by Autodesk, but the functionality can be expanded to include your own macros
or reports. The buttons on the top of the Toolbox shown in Figure 1.13 allow you to customize the
report settings and add new content.

FIGURE 1.13 X
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@ Real World Scenario

A TOOLBOX BUILT JUST FOR YOU

The Toolbox content and the Report Settings can be edited by selecting the desired tool, right-clicking,
and then executing. Don’t limit yourself to the default reports that ship in the Toolbox, though. Many
firms find that adding their in-house customizations to the Toolbox gives them better results and is
more easily managed at a central level than by customizing via the AutoCAD common user interface
(CUI) and workspace functionality.

Let’s add one of the sample Civil 3D Visual Basic Application (VBA) macros to a new Toolbox:
1. Clickthe Edit Toolbox Content button shown in Figure 1.13 to open the Toolbox Editor in Panorama.

2. Click the button shown here to add a new root category.

’é#wfn EN sHua

+ BB Reparts Manager Progerty Yake
= General 2
Mamne Reports Managet ug.u
Cescription

Toolbox Editor

PANORAMA

ms
D

3. Click on the Root Category1 toolbox that appears. The name will appear in the preview area, where
you can edit it. Change the name to Sample Files, and press .

4. Right-click on the Sample Files toolbox, and select New Category as shown here.
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5. Expand the Sample Files toolbox to view the new category, and then click on the name to edit it in
the preview area. Change the name to VBA, and press ..

6. Right-click on the VBA category and select New Tool.

7. Expand the VBA category to view the new tool, and then click on the name to edit it in the preview
area. Change its name to Pipe Export.

- @
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8. Change the Description to Runs Autodesk’s sample Pipe Export VBA Macro.

9. Working down through the properties in the preview area, select VBA in the dropdown menu in the
Execute Type field.

11.BrowsetoC:\Program Files\Autocad Civil 3D 2008\SampTle\Civil 3D API\VBA\Pipe\
and select the file Pipe Sample Application.dvb.

12. Click Open.
13. Click in the Macro Name text field, and type PipeSamples.ExportToExcel as shown here.
X 5
4 4 A “HAad
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= &F vBA Namne Fipe Expart :
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Exmcue Als CiiProgram FilesiiucoCAD Cril 20 2008 Samplel O, 5
Macro Maire FpeSainples Export ToEecel £
E Help T
Help Fil L
Heks Tapic E

PANORAMA

=
-

The text PipeSamples.ExportToExcel was determined by using the AutoCAD VBAMAN command to
load up the same . dvb file, clicking the Macros button in that dialog and copying the text from the
Macro Name text field. The portion of the text that comes after the . dvb file extension in that text box
is the macro name as required by the Toolbox Editor.

14. Click the green checkbox in the upper right to dismiss the editor.

You’ve now added that sample VBA macro to your Toolbox. By adding commonly used macros and
custom reports to your Toolbox, you can keep them handy without modifying the rest of your Civil
3D interface or programming buttons. It’s just one more way to create an interface and toolset for
the way you work.

Panorama

The Panorama window is Civil 3D’s feedback and tabular editing mechanism. Designed to be a
common interface for a number of different Civil 3D-related tasks, it can be used to provide infor-
mation about the creation of profile views, to allow the editing of pipe or structure information, or
the running of basic volume analysis between two surfaces. Panorama typically isn’t displayed
when Civil 3D is launched. Select General > Utilities > Event Viewer to display the Event Viewer,
one of many Panorama uses. We’ll explore and use Panorama more as we get into specific objects
or tasks.

- @
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RUNNING OUT OF SCREEN REAL ESTATE?

It’s a good idea to turn on Panorama using this technique, then drag it to the side so that you’ll always
see any new information. While it is possible to turn it off, it’s not recommended—you won’t know
when Civil 3D is trying to tell you something! Place it on your second monitor (by now, you see why you
do need to have a second monitor, don’t you?), and you’ll always be up to date with your Civil 3D model.

And in case you missed it, we were using Panorama when we added the sample VBA macro in the pre-
vious exercise.

It’s All About Style

Before we get into the program itself, it's important that we cover one bit of vocabulary and how
it relates to Civil 3D: style. To put it simply, styles control the display properties of Civil 3D objects
and labels. Styles control everything from the color of your point markers to the interval of your
surface contours and from your profile view grid spacing to the text height in the Station-Offset
label of your road alignment. Styles truly are where the power in Civil 3D lies. Label styles and
object styles are the two major categories.

The difficult thing about styles is that it’s hard to talk about them without being specific. We’ll
spend a fair amount of time in later chapters talking about the specifics of the styles for each object
and some time in this chapter looking at the common aspects of style manipulation, but they might
remain a mystery until you really get your hands dirty in later chapters.

Label Styles

To get started, we can look at the styles in the Spot Elevation branch by expanding the Surface
branch and then the Label Styles branch on the Settings tab, as shown in Figure 1.14.

There are two basic label styles in the Spot Elevation branch. Let’s create a new one and explore
the options for making labels. Remember, almost all of these options will be present in other, object-
specific label styles.

FIGURE 1.14 .
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First, right-click the Spot Elevation folder and select New in the pop-up menu to open the Label
Style Composer, as shown in Figure 1.15.
On the Information tab, change the name to something appropriate. In this case, we’ll use

JW-EG.
FIGURE 1.15 &
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It’s a good idea to always put something in the style name to indicate it wasn’t one in the box. Putting
your initials or firm at the beginning of the style is one way to make it easy to differentiate your styles
from the prebuilt ones. Here, JW stands for James Wedding (EG stands for Existing Ground).

Next, switch to the General tab. Change the layer to C-TOPO-TEXT by clicking the layer cell
and then the More button to the right of that cell. There are a fair number of options
here, so let’s look at them further:

Text Style is the default style for the text components that will be created on the Layout tab. It’s
a good practice to just use a zero-height text style with the appropriate font since you'll set the
plotted heights in the style anyway.

Layer is the layer that the components of a label get inserted on, not the layer the label itself gets
inserted on. Think of labels as nested blocks. The label (the block) gets inserted on the layer on
the basis of the object layers we looked at earlier. The components of the label get inserted on the
layer that is set here. This means a change to the specified layer can control or change the appear-
ance of the components if desired.

Orientation Reference sets an object to act as the up direction in terms of readability. Civil 3D
understands viewpoint rotation and offers the option to rotate or flip labels to keep them plan
readable. Most users will want to set this to View to maintain the most plan-readable labels with
the smallest amount of editing later.

- @
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Forced Insertion makes more sense in other objects and will be explored further. This feature
essentially allows you to dictate the insertion point of a label on the basis of the object being
labeled.

Plan Readable text maintains the up direction in spite of view rotation. This tends to be the
“Ooooh, nice” feature that sets users to smiling. Rotating a hundred labels is a tedious, thankless
task, and this handles it with one click.

Readability Bias is the angle at which readability kicks in. This angle is measured from the
zero degree of the X axis that is common to AutoCAD angle measurements. When a piece of
text goes past the readable bias angle, the text spins to maintain vertical orientation, as shown
in Figure 1.16. Note how the label on the far left has rotated to accommodate the rotation past
110 degrees, the default bias ang]le.

Flip Anchors With Text determines how the text flips. Most users find that setting this to False
gives the best results, but sometimes flipping an anchor point will position text as needed. We’ll
talk more about anchor points on the Layout tab.

Switch to the Layout tab. Again, there’s a whole lot going on here, so we’ll work through the
options, and then make changes. As shown in Figure 1.17, each component of the label has a whole
host of options.

FIGURE 1.16
Examples of plan-
readable text

NO® 00" 00.00"E
300.000°
9

X




%% é 67403.book Page 20 Friday, August 31,2007 2:12 PM

20 | CHAPTER 1 GETTING DIRTY: THE BASICS OF CIVIL 3D

FIGURE 1.17 &
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To the right-hand side is a preview of the label you are creating or editing. This view can be
panned or zoomed as needed to give you a better feel for the label style’s appearance as you make
changes.

A FULL THREE-DIMENSIONAL LABEL PREVIEW?

This preview defaults to a 3D orbit control. Don’t ask us why; we honestly are as confused as you are.
Inevitably, you will rotate the view out of a plan-top view, making the plan harder to understand. When
this happens, right-click and select Preset Views > Top to reorient yourself.

Labels are made of individual components. A component can be text, a block, or a line, and the
top row of buttons controls the selection, creation, and deletion of these components:

Conpone it e

« The Component dropdown menu activates which component is being modified in the options
below. These components are listed in the order in which they were created.

The Create Text Component button allows for the creation of new components. These compo-
nents can be Text, Lines, Blocks, Reference Text, or Ticks. Some options are not available for
every label style.

The Copy Component button does just that. It copies the component currently selected in the
Component dropdown menu.

The Delete Component button deletes components. Elements that act as the basis for other com-
ponents cannot be deleted.

The Component Draw Order button allows the components to be shuffled up and down within
the label. This feature is especially important when using masks or borders as part of the label.

# X (&
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Let’s work our way down the component properties and adjust them as needed for our label:

Name is self-explanatory. It is the name used in the Component dropdown menu and when
selecting other components. When building complicated labels, a little name description goes a
long way.

Visibility set to true means that this component will show on screen. Invisible components can
be invaluable when creating complicated labels, as you’ll see in later chapters.

Anchor Component and Anchor Point are straightforward, but many users have issues when
first using these options. Every component of the label has an anchor component, anchor point,
and attachment. The Anchor Component is how you tell Civil 3D where you want to hang the
label component. This component is bounded by a box, with nine anchor points, as shown in
Figure 1.18. In this illustration, the nine possible anchor points are represented with X’s and the
nine possible attachments with O’s.

FIGURE 1.18
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The middle portion of the dialog changes depending on the type of component, but the concepts
are similar. In the case shown here, the middle portion is the Text property. Under Text, the first
option is Contents, which determines the actual content of the text.

1. Click the Contents Value cell, then click the ellipsis button that appears to the right to open
the Text Component Editor.

2. C(lickin the preview window of the Text Component Editor. This is a simple text editor, and
you can type anything you’d like in a label here. Additionally, you can insert object infor-
mation from Civil 3D objects as we’ll do now.

3. Highlight and delete the text that is in the preview window.

4. On the left-hand side, select Surface Elevation from the dropdown list in the Properties
text box.

5. Change the precision to one decimal place by clicking in the column next to precision and
selecting 0.1, as shown in Figure 1.19.

6. Click the blue arrow circled in Figure 1.19 to insert your label text and elevation code into the
preview area.

7. Click OK to exit this dialog, and you'll be back at the Label Style Composer.

4~ 40
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FIGURE 1.19
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How MANY DIALOGS IS THAT?

You can now see why many Civil 3D instructors refer to label creation as heading down the rabbit hole.
We’re a couple of dialogs deep in just making the simplest of label styles, with one static text compo-
nent. It’s easy to get confused, but don’t worry—it becomes second nature! The Text Component Editor
is another common dialog that appears in every label style creation exercise.

Let’s look at the rest of the options, even though we won’t be making any changes:

Text Height determines the plotted height of the label. Remember, Civil 3D knows you're going
to print and will attempt to give you inches or millimeters.

Rotation Angle, X Offset, and Y Offset give you the ability to refine the placement of this com-
ponent by rotating or displacing the text in an X or Y direction.

Attachment determines which of the nine points on the label components bounding box will be
attached to the anchor point. See Figure 1.19 for an illustration.

Color and Lineweight allow you to hard-code a color if desired. We suggest you leave these
values set to ByLayer unless you have a good reason to change them.

The final piece of the component puzzle is a Border option. These options are as follows:

Visibility is an obvious one, turning the border on and off for this component. One thing to
remember is that component borders shrink to the individual component, so if you are using
multiple components in a label, they all have their own borders.

Type allows you to select a rectangle, a rounded rectangle (slot), or a circle border.

Background Mask allows the user to determine whether linework and text behind this compo-
nent is masked. This can be handy for construction notes in place of the usual wipeout tools.

Gap determines the offset from the component bounding box to the outer points on the border.
Setting this to '/, or ', the text size usually creates a visually pleasing border.

Linetype and Lineweight allow the usual control of the border lines.

%
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After working through all of the options for the default label placement, you need to work
through the options that come into play when a label is dragged. Switch to the Dragged State tab.
When a label is dragged in Civil 3D, it typically will create a leader and text will rearrange. The set-
tings that control these two actions are on this tab. Unique options are explained here:

Arrow Head Style and Size control the tip of the leader. One thing to note is that Arrow Head
Size also controls the tail size leading to the text object.

Type controls the leader type. Options are Straight Leader and Spline Leader. At the time of this
writing, the AutoCAD multiple leader object cannot be used.

Display controls whether components rearrange their placement to a stacked set of components
(Stacked Text) or maintain their arrangement as originally composed (As Composed). Most
users expect this to be set to As Composed for the most predictable behavior.

Switch to the Summary tab and click the Expand All button circled in Figure 1.20. Working
down the Summary tab, you can review all of the options that have been selected for an individual
label, as well as look for overrides, just like we did on the Settings tab. Click OK to exit the dialog;
your new style will appear on the Settings tab.

The purpose of this exercise wasn’t to build a Surface Spot Elevation label style; it was to famil-
iarize you with the common elements of creating a label: the Label Style Composer and the Text
Component Editor. We'll cover more complex label styles and the creation of more common labels
in later chapters.
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Object Styles

Beyond the styles used to label objects, Civil 3D also depends on styles to control the display of the
native objects, including points, surface, alignments, and so on. Just as in label styles, certain com-
ponents of the object styles are common to almost all of the objects, so let’s create a new alignment
style to introduce these common elements.

1. Expand the Alignment branch on the Settings tab, and then right-click on the Alignment
Styles folder. Select New, as shown in Figure 1.21.

2. Type a new name for your style on the Information tab and enter a description if desired.

3. Switch to the Display tab. While the other two tabs are unique for alignment objects, the
Display tab is part of every Civil 3D object style.

4. Turn off the Arrow component by clicking the lightbulb in the column next to it.

5. Near the top of the dialog, change the View Direction setting in the dropdown menu to 3D
and notice the change.

6. Click OK to dismiss the dialog. Your new alignment style will appear under the Alignment
Styles branch in the Settings tab.

Objects can have distinctly different appearances when being viewed in a plan view versus a
3D view. For example, surfaces are often represented by contours in plan view, but triangular faces
or a grid in 3D.

Object styles are a major component of efficient Civil 3D object modeling. Objects appear differ-
ently in varying plans. Having a full set of object styles to handle all of these use cases will make
plan production as painless as possible.

A good way to start creating object styles is to pull out a set of existing plans that represent your
firm’s standards accurately. Pick an object, such as alignments or surfaces, and then begin working
your way through the plan set, creating a new object style for all of the various use cases in your
plan set. Once you complete one object, pick another, and repeat the exercise.
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The Underlying Engine

Civil 3D is part of a larger product family from Autodesk. During its earliest creation, various fea-
tures and functions from other products were recognized as important to the civil engineering com-
munity. These include the obvious things like the entire suite of AutoCAD drafting, design,
modeling, and rendering tools and then to some more esoteric options like Map’s GIS capabilities.
An early decision was made to build Civil 3D on top of the AutoCAD Map product, which in turn
is built on top of AutoCAD.

This underlying engine provides a whole host of options and powerful tools for the Civil 3D
user. AutoCAD and Map add features with every release that change the fundamental makeup of
how Civil 3D works. With the introduction of workspaces in 2006, users can now set up Civil 3D
to display various tools and palettes depending on the task at hand. Creating a workspace can be
thought of as having a quick-fix bag of tools ready for the job at hand: preliminary design calls for
one set of tools, and final plan production calls for another.

Workspaces are part of a larger feature set called the custom user interface, typically referred to
as CULin the help documentation and online. Creating workspaces is relatively simple, especially
as we'll be focusing on the display and control of toolbars and not creating new ones.

Table 1.1 shows the default workspaces and their menus that ship with Civil 3D 2008. As you
can see, there are a fair number prebuilt for major design tasks. This is a marked improvement from
2007, when only one basic Civil 3D workspace was included in the product.

The Workspaces toolbar is on by default, but if it is not visible, you can access it by right-clicking
in any gray area around the drawing window and selecting ACAD > Workspaces to display the

toolbar.
TABLE 1.1: Workspace and Menu Reference Table
CiviL 3D ANNOTATION SURVEYING AND  VISUALIZATION
MENU COMPLETE DESIGN AND DRAFTING TOPOGRAPHICAL AND RENDERING
File X X X X
Edit X X X X X
View X X X X
Insert X X X X X
General X X X X
Lines/Curves X X X
Points X X
Surfaces X X X
Parcels X X
Grading X X
Alignments X X X
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TABLE 1.1: Workspace and Menu Reference Table (CONTINUED)
CiviL 3D ANNOTATION SURVEYING AND VISUALIZATION
MENU COMPLETE DESIGN AND DRAFTING TOPOGRAPHICAL AND RENDERING
Profiles X X
Corridors X X
Sections X
Pipes X
Survey X
Annotation X X
Inquiry X X X
Express X X X X
Window X X X X X
Help X X X X

As you can see from the table, each of these workspaces was designed with user roles in mind.
By using these as templates for your own workspaces, you can make Civil 3D work the way you do.

The Bottom Line

Find any Civil 3D object with just a few clicks. By using Prospector to view object data col-
lections, you can minimize the panning and zooming that are part of working ina CAD program.
When common subdivisions can have hundreds of parcels or a complex corridor can have doz-
ens of alignments, jumping to the desired one nearly instantly shaves time off everyday tasks.

Master It Open SampleSite.dwg from the sample data set and find the parcel Property : 9
without using any AutoCAD commands.

Modify the drawing scale and default object layers. Civil 3D understands the end goal of
most drawings is to create hard-copy construction documents. By setting a drawing scale and
then setting many sizes in terms of plotted inches or millimeters, Civil 3D removes much of the
mental gymnastics that other programs require when sizing text and symbology. By setting
object layers at a drawing scale, Civil 3D makes uniformity of drawing files easier than ever to
accomplish.

Master It Change SampleSite.dwg from a 40-scale drawing to a 200-scale drawing.

Modify the display of Civil 3D tooltips. The interactive display of object tooltips makes it
easy to keep your focus on the drawing instead of an inquiry or report tools. When too many
objects fill up a drawing however, it can be information overload, so Civil 3D gives you granular
control over the heads-up display tooltips.

Master It Within the same Sample Site drawing, turn off the tooltips for the Carson’s Way
alignment.
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Add a new tool to the Toolbox. The Toolbox provides a convenient way to access macros and
reports. Many third-party developers are exploiting this convenient interface as an easier way
to add functionality without disturbing users” workspaces.

Master It Add the Import From Excel macro from C:\Program Files\Autocad Civil 3D
2008\SampTe\Civil 3D API\VBA\Pipe\ and select Pipe Sample Application.dvb.

Create a basic label style. Label styles determine the appearance of Civil 3D annotation. The
creation of label styles will constitute a major part of the effort in making the transition to Civil
3D as a primary platform for plan production. Your skills will grow with the job requirements
if you start with basic labels and then make more complicated labels as needed.

Master It Create a copy of the Elevation Only Point label style, name it Elevation With
Border, and add a border to the text component.

Create a new object style. Object styles in Civil 3D allow the user to quit managing display
through layer modification and move to a more streamlined style-based control. Creating
enough object styles to meet the demands of plan production work will be the other major task
in preparing to move to Civil 3D.

Master It Create a new Surface style named Contours_Grid and set it to show contours in
plan views but a grid display in any 3D view.
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